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By: Ted Harris and Eric Miller
Wow.  ANSYS, Inc. released 12.1 within 8 months or so of the release of 12.0.  The
folks at ANSYS, Inc. have been busy!  Let’s take a look at some key changes in the
12.1 release.  We’ll Focus on what we consider to be the heavy hitters for the bulk of
users.  Please see the Release Notes or an update presentation for more details. To save
time and space we have just bulleted a lot of the information rather than phrasing
everything in lengthy, but beautiful prose.

Licensing
A new version of the license manager is required to run 12.1.  Older versions of
ANSYS products still work with the new license manager.  We still have the ANSYS
License Interconnect to deal with, but our observations are that the startup is faster

than it was at 12.0.  Here are some additional enhancements:

· Additional Fluent products are now licensed with ANSYS License Manager (e.g. Icepak and Polyflow).
· HPC license changes - more cost-effective bundles are available.
· No longer need Mechanical HPC license to use the VT Accelerator.

Mechanical APDL
In case you missed it, “Mechanical APDL” is the official name for ANSYS ‘classic’ since the 12.0 release.  This was done in part to
demonstrate ANSYS, Inc.’s commitment to APDL , the ANSYS command language for the long-time ANSYS interface.  Enhancements
at 12.1 include:

· In HPC and parallel computing, Shared Memory Parallel solutions now perform the element stiffness calculations in parallel.
You may find this speeds up some solutions vs. prior versions of ANSYS.  Also, modal cyclic symmetry solutions are now
supported for distributed parallel solutions.  The PCG Lanczos mode extraction method has been enhanced to reduce I/O.

· Enhancements to structural dynamics capabilities include faster Mode Assurance Criterion calculations, modification to the
ANHARM command to support animation of complex mode shapes for all complex eigensolvers, and improvements to the
CMOMEGA, CMDOMEGA, and CMACEL commands which remove the restriction on the number of components allowed.

Jet Tour of Release 12.1

(Cont. on pg. 2)

By: Clinton Smith
Recent advances in computational
fluid dynamics (CFD) have been in
the area of non-boundary conform-
ing methods. These methods relax
the requirement that the grid con-
forms to the body, and instead repre-
sent complex bodies by appropriate
treatment of the solution variables
near the body (ref. Figure1).
Immersed boundary methods repre-
sent a subset of these techniques in
which forcing of the momentum
field is used to represent the effect of
an object in the flow. The primary
advantage of these
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Figure 1: Treatment of Mesh Points in Immersed

Boundary Method
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· In electromagnetic, there is a new element type, PLANE233.  This allows for planar and axisymmetric magnetic fields.  It’s
second order, with quadrilateral or triangular shape.  It has the AZ and VOLT dof’s and is intended, along with the fairly recently
developed multiphysics element PLANE223, to replace the older PLANE13 element type.

· In the heat transfer realm, the SURF152 element type has been enhanced to support two extra nodes, allowing it to connect to
both nodes of a FLUID116 element.  There is a new MSTOLE command that can be used to connect FLUID116 and SURF152.
FLUID116 itself has been enhanced to support two new discretization schemes for shape functions, allowing users to capture
specific temperature gradients with fewer elements than was possible before.

· The Help system has a new addition:  the Technology Demonstration Guide.  This has several nice, practical examples of typical
problems that we might need to solve in our jobs.  For instance, the first topic on the list is Nonlinear Analysis of a 2-D
Hyperelastic  Seal Using Rezoning.  Another Help system improvement is that it now contains detailed info on how to use DLL’s
on Windows for custom versions of ANSYS.

Workbench (Top Level)
· Support for Linux is new at 12.1, on Redhat Enterprise Linux 5 (32 bit) and SUSE Linux Enterprise
10 (64 bit).  Although most Workbench applications are supported, the big exceptions are Mechanical
(formerly Simulation) and FE Modeler.
· New journaling and scripting capabilities!  You can now capture the steps you have followed using a
journal file.  You can also write your own Workbench scripts.  Keep in mind this is for the top level
Workbench page, not Mechanical, at 12.1.  In theory, one could combine Workbench Scripting with the
jScript scripting for DesignModeler, for instance, along with APDL for advanced preprocessing or
solution options.  The new scripting is Python based, and best of all, it is well documented in the Help.
· There is also a new External Connection Add-in.  This allows sharing parameters with external
applications, through the use of an XML configuration file.  This is also documented in the 12.1 Help,
in the External Connection Add-In for Workbench Guide.

Workbench Mechanical
-When plotting geometry, you can now hide faces of bodies to ‘see’ inside.

-Node number control in meshing:  You can now specify a Mesh Numbering branch in the outline tree
which allows you to specify node or element number offsets to a body.  Further, you can renumber a

vertex or a single node such as a point mass.

-Connections have been improved so that joint rotation angles can be typed in.  There is
additional support for line body bonded contact for both Autodyn and LS-DYNA
solutions, and keyword snippets can be attached to contact regions for LS-DYNA as well.

-A new capability involves defining constraint equations between remote points.  This is
accomplished by inserting a Constraint Equation branch under the analysis type branch.
Constraint equations can be generated to tie degrees of
freedom for remote points as defined in a remote point
branch under the model branch, using a mathematical
relationship, such as 0.5 =
2*UX(point1)+0.25*UY(point2).

-Line pressures can now be applied as a function of the
length along the line.  The parametric distance can be used
in an equation, such as a sinusoidal equation.

-In the thermal realm, a major enhancement is the ability to include surface to surface radiation effects,
rather than the prior black body capability.  Two groups of surfaces can now be specified for radiation heat
transfer.  Another new capability is the application of Icepak thermal results as a load in Mechanical.

- Results postprocessing has been made more powerful with the ability to snap a results path to the mesh
to ensure the path remains inside the mesh from beginning to end.  Additionally, it is now possible to
define a plane onto which results can be scoped.  This gives us more control over viewing internal results.
Other improvements are that most result items now having averaged and unaveraged options along with
the ability to view results in nodal or element coordinate systems.

DesignModeler
· New Autosave capability, which occurs after every few regenerations.  There is also an AutoSave Now menu pick and a Restore

AutoSave File menu pick for additional control over autosaved files.

Mesh Numbering Control

Sinusoidal Line Pressure

Results Scoped to a Surface

(Tour, Cont...)

(Cont. on pg. 3
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Maximum Corner Angle Mesh Metrics

· Hide Faces of bodies applied to DM, as described above for Mechanical.
· You can now load an existing DesignModeler database from the File menu, without going back to the Project Schematic.
· Midsurface extraction has been improved, including more robust treatment of automatic face pairs when holes and slots are

involved.
· There is a new tool to detect and remove ‘Hard Edges’, which might also be described as internal on non-boundary edges that

exist within a surface.
· Enclosure creation has been enhanced in that you can specify different offsets in X, Y, or Z for the walls of the enclosure.

Meshing Application
The Workbench Meshing Application has been augmented to include support for Linux.
Additionally, the beginnings of scripting are available from the Project Schematic level.  Here
are some other key enhancements:

· Can mesh zero thickness walls in non manifold geometry, such as for baffles.
· Faceted geometry may be exported for use in TGRID.
· There are additional controls and capabilities for meshing with inflation layers, including
Named Selection use and inflation from zero thickness walls.
· Virtual topology has been improved for ‘paving over’ small features with larger elements.
· The Multizone mesh method for creating hex meshes has been made more robust, as has
the Sweep meshing method.
· The Patch Independent Tetra method has been enhanced as well, allowing for better
handling of large models and complex geometry.

· Smoothing is improved, including an additional pass to improve skewness when smoothing is set to high.
· Finally, another new capability is a bar graph added to mesh metrics.  Previously we had to move to FE Modeler to view mesh

metrics for Workbench meshes.  Now this can be done by expanding the Statistics item in the Mesh details, then specifying one
of the available metrics:

· Element Quality
· Aspect Ratio
· Jacobian Ratio
· Warping Factor
· Parallel Deviation
· Maximum Corner Angle
· Skewness

This concludes our jet tour.  Like a lot of trips, we hit some highlights but didn’t see everything.  We hope you will explore 12.1 on your
own to see what new features and capabilities might make you more productive with the ANSYS family of products.  We’ll try to cover
additional details in future issues as well.

Mesh with Zero Thickness Walls

The Editor for ANSYS APDL Users
PeDAL is a Windows text editor for ANSYS APDL scripts. It integrates with the ANSYS help
system to provide instantaneous help on any one of the 1,000s of ANSYS commands. PeDAL
was written by Matt Sutton, an Engineer at PADT, to make his own job easier. Matt has years
of experience writing APDL scripts and has long wished for a tool that would provide help for
a given command right at his fingertips. Pedal can be purchased for $49 by pressing on the
Buy Pedal button below.

Key Features
� Side-by-side editor and help viewer layout.
� Instant help on any documented APDL command by pressing F1.
� Full syntax highlighting for ANSYS v12 Mechanical APDL.
� Auto-complete drop downs for APDL Commands.
� APDL Command argument hints while typing commands.
� Mouse hover command descriptions.
� Much More...

Download your 30 day trial or learn more details at:
www.padtinc.com/pedal

(Tour, Cont...)

http://www.padtinc.com/pedal
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methods is that grid generation is simplified. The immersed boundary technique
has been used extensively among academic researchers to study fluid physics in
many types of flows, from bluff body aerodynamics (ref. Figure 2) to the biome-
chanics of heart valves. Now, the particular advantages provided by this tech-
nique are being implemented by industry researchers and engineers.
In 2009 (as part of the release of ANSYS 12.0), ANSYS Fluent implemented an
immersed boundary solver developed by Cascade Technologies. The ANSYS
Fluent Immersed Boundary module consists of two basic parts: an automatic
mesh generator (nicknamed “Tommie”) and the immersed boundary modifica-
tions to the standard flow solvers within Fluent 12.0.
Access / Implementation Details
The Immersed Boundary module is available as a separately purchased add-on
module for standard ANSYS Fluent.  It also requires a special license, which is
available for download on the ANSYS Customer Portal
(http://www1.ansys.com/customer/). Once downloaded and installed, the Im-
mersed Boundary module appears very similar to the standard Fluent 12.0 GUI.
The addition of a menu-bar option labeled “Tommie” is the only difference in the
basic user-interface, but exploration of its capability reveals some interesting functionality, the most important of which is the rapid mesh
generation capability from basic geometry files (STL format).
Some of the functionality of the Immersed Boundary module within Fluent include, but are not limited to: 2D and 3D flows; steady and
unsteady solution; inviscid, laminar, and turbulent flows (Spalart-Allmaras, k-epsilon, k-omega, and DES turbulence models); parallel
processing for meshing and the flow solver; pressure-based solver with segregated and coupled algorithms; heat transfer (forced, natural,
and mixed convection); material properties database. Not every possible capability of ANSYS Fluent is compatible with the current
release of the Immersed Boundary module (though we expect that more of these features will become available in upcoming releases):
some of the features which are not compatible are radiation heat transfer; multiphase flow; dynamic and moving meshes; chemical species
transport; and conjugate heat transfer.

The Focus is a periodic publication of Phoenix Analysis & Design Technologies (PADT).  Its goal is to educate and entertain the worldwide
ANSYS user community.  More information on this publication can be found at: http://www.padtinc.com/epubs/focus/about

(Immersed Boundary Cont...)

(Cont. on pg. 5

Figure 2a: Flow over a sedan at 100 mph: instantaneous
vorticity contours

Figure 2b: Flow over a sphere at Re = 300: instantaneous
velocity magnitude

(Cont. on pg. 5)

PADT’s Training Schedule
Month Start End # Title Location
Feb ‘10 2/11 2/12 652 CFX Multiphase Flows Tempe, AZ

2/16 2/25 113 Introduction to ANSYS Workbench Mechanical (Web Class) Web Based
2/19 2/19 206 ANSYS Workbench Mechanical Rigid & Flexible Dynamics Tempe, AZ
2/22 2/23 202 ANSYS Mechanical APDL Basic Structural Nonlinearities Tempe, AZ
9/28 9/29 104 ANSYS WB Simulation – Introduction Las Vegas., NV

Mar '10 3/1 3/2 103 Introduction to ANSYS Workbench Mechanical Tempe, AZ
3/3 3/4 207 ANSYS Workbench Mechanical – Structural Nonlinearities Tempe, AZ
3/8 3/9 203 ANSYS Mechanical APDL Dynamics Tempe, AZ

3/11 3/12 501 ANSYS/LS-DYNA Tempe, AZ
3/15 3/16 604 Introduction to CFX Tempe, AZ
3/17 3/17 112 Introduction to ANSYS Meshing Tempe, AZ
3/18 3/18 107 ANSYS Workbench DesignModeler Tempe, AZ
3/22 3/24 902 Multiphysics Simulation for MEMS Tempe, AZ
3/25 3/25 653 CFX Turbulence Modeling Tempe, AZ
3/30 3/31 502 ANSYS Explicit STR Tempe, AZ

Apr '10 4/6 4/15 113 Introduction to ANSYS Workbench Mechanical (Web Class) Web Based
4/7 4/9 101 Introduction to ANSYS (Mechanical APDL), Part I Tempe, AZ

4/14 4/16 401 ANSYS Mechanical APDL Low Frequency Electromagnetics Tempe, AZ
4/19 4/20 201 ANSYS Mechanical APDL Basic Structural Nonlinearities Tempe, AZ
4/21 4/22 204 ANSYS Mechanical APDL Advanced Contact and Fasteners Tempe, AZ

May '10 5/4 5/5 103 Introduction to ANSYS Workbench Mechanical Las Vegas, NV
5/6 5/7 100 Engineering with Finite Element Analysis Tempe, AZ

5/10 5/10 107 ANSYS Workbench DesignModeler Tempe, AZ
5/11 5/12 205 ANSYS Workbench Mechanical Dynamics Tempe, AZ
5/14 5/14 702 ANSYS DesignXplorer Tempe, AZ
5/17 5/18 207 ANSYS Workbench Mechanical – Structural Nonlinearities Tempe, AZ
5/19 5/20 302 ANSYS Workbench Simulation 11.0 Heat Transfer Tempe, AZ

http://www.turbulentflow.com
http://www.padtinc.com/epubs/focus/about
http://www.padtinc.com/epubs/focus/default.asp
http://www.padtinc.com/support/training/
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Example: Pre-Process and Solution of the Flow over a Smooth Sphere
The flow over a smooth sphere is a part of the “canon” of well-known fluid
mechanics problems, and presents an opportunity to test the capability of the
Fluent Immersed Boundary module.
Pre-processing using Tommie

1. Import STL file
a. Tommie – Create Input – Boundaries – Add
b. Type “sphere”, click OK
c. Settings – Add – Select STL file (create a sphere of diameter 1 m and save as STL)
d. Tangential & Normal Mesh Size = 0.01
e. Apply

2. Specify the domain
a. Select Domain tab
b. Xmin, Xmax = (-10,20); Ymin,Ymax = (-5,5); Zmin, Zmax = (-5,5)
c. Material point = (-1,1,1)
d. Apply

3. Select mesh parameters
a. Select Mesh tab
b. Mesh Size: Dx = 0.25, Dy = 0.25, Dz = 0.25
c. Set Global Smooth = 3
d. Type “sphere” for the Case Name and click Apply

4. Write output file
a. At the bottom of the Tommie “Create Input” menu, select Write
b. Write out the Tommie input file (default is named “tommie.in”)

5. Generate mesh
6. Tommie – Generate Mesh

a. Browse – Select the “tommie.in” file create in step 5
b. Click OK to generate the mesh and the case file

Once the mesh has been generated, the Fluent Immersed Boundary module
writes a Fluent case (*.cas) file that can be read in via “File – Read – Case” as
with standard Fluent case files.  Following the above procedure produces the
domain and mesh shown in Figure 3a and 3b, respectively.  Further refinement
of the mesh can be carried out by further iterations of Tommie. An example can
be seen in Figure 4, where a region of refinement is specified and modified in
the wake behind the sphere. Further efficiency in the meshing process is avail-
able by running Tommie in parallel.
One of the most attractive features of the Fluent Immersed Boundary module is
the time needed to run Tommie.  For the most refined mesh in the current work
(displayed in Figure 4 c), which has 1.8 million cells, the time needed to generate
the mesh is approximately 4 minutes on a Windows machine with 8 GB of RAM.
The procedure for configuring a Fluent simulation is identical to the specifica-
tion of the solution in which the grid conforms to the boundary. An immersed
boundary result of the flow over a sphere at a Reynolds number of 300 is
displayed in Figure 5. The flow in the wake is visualized using a vortex identifi-
cation method that isolates convex, low-pressure tubes, which are usually asso-
ciated with coherent vortices.
Conclusion
The immersed boundary method implemented within Fluent is robust and easily
to use, as the only learning required is the usage of the Tommie interface with the standard Fluent GUI.  ANSYS Fluent’s Immersed
Boundary module presents a distinct advantage over conventional boundary-conforming approaches in terms of grid generation. The setup
of a simulation project is greatly simplified, as a basic CAD model (STL format) can be directly processed in the CFD environment.
Complex geometry can be efficiently handled without having to simplify or modify features, which often proves to be very time-
consuming. The quality of mesh can be strictly controlled by the user, and local refinement can be carried out wherever it may be needed
to capture the appropriate physics. Setup and solution of the problem
using the Fluent Immersed Boundary module are identical to a conven-
tional Fluent simulation. Preliminary simulation results using the
Immersed Boundary module indicate good comparison with previous
calculations. Further information about the joint venture between
ANSYS Fluent and Cascade Technologies can be found in the press
release at:
anss.client.shareholder.com/releasedetail.cfm?ReleaseID=406049.

Specifics about immersed boundary method theory and the nature of
its implementation within ANSYS Fluent can be obtained by contacting us
here at PADT.

(Immersed Boundary Cont...)

Figure 4a: Mesh Refined  3 m behind, Refinement = 1

Figure 4b: Mesh Refined  5 m behind, Refinement = 1

Figure 4c: Mesh Refined  5 m behind, Refinement = 1.2

Figure 3a: Sphere Solution Domain

Figure 3b: Preliminary Grid from Tommie

Figure 5: Sphere solution at Re = 300: Vortex identification
method of Hunt, Wray, and Moin (1988)

http://anss.client.shareholder.com/releasedetail.cfm?ReleaseID=406049.
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By: Eric Miller
In general we try and avoid writing articles about beta features
simply because they are beta features – they can be a bit buggy,
things will change in future releases, and documentation is spotty.
But when we used the new cyclic symmetry capabilities exposed as
beta features in 12.1, we thought the improvements in this area
were worth sharing.

If you work on any type or rotating machinery or round stuff in
general, you probably have been a bit frustrated by the lack of
direct support in ANSYS Mechanical (formerly Workbench Simu-

lation) for cyclic symmetry.  You could always throw in some command objects and get what you needed, but that is not always as
efficient as using the native interface.  There is a major effort by ANSYS, Inc. development to fully support cyclic symmetry at R13,
and the pieces that were done at the time of the 12.1 release are available to users as beta features.

To use these feature you need to follow the steps listed below.  But before you do that you need to make sure that your geometry is
cyclically symmetric.  And, for greater accuracy, make sure that the topologies on the surfaces that define your periodic boundaries are
also identical. Also, it should be noted that for this article we are doing a modal analysis and we assume that you are familiar with cyclic
symmetric modal analysis in ANSYS Mechanical APDL and understand the math and terminology behind that type of analysis.

Step 1: Turn on the features
The first thing you need to do is turn on Beta features by going to Tools->Options->Appearance.  Scroll down and you will see a check
box “Beta Options”  Make sure it is checked and click OK (Figure 1).  Now you can see the beta commands but in order to get the results
to calculate correctly you need to set a flag.  To do this go to Tools->Variable Manager  Right click on the table and choose “Add” then
put cyclic in as the variable name and 1 as the value.  Make sure you click Active before you click OK.  If you want to animate traveling
waves, then create cyclicWave and set it to 1 as well.  Figure 2 shows what it should look like

Step 2: Setup up periodic symmetry
In order to tell the program you have a cyclic symmetric part you need to give it information about how it is symmetric, and this starts
with creating a cylindrical coordinate system around which your part is symmetric.  Do this by inserting a new Coordinate System under
Coordinate Systems in the tree. Make sure you define it as Type=Cylindrical and that its Z axis is aligned with your part’s axis.  It is
also a good idea to give it a descriptive name like CylCSYS or RotAx or something similar so you can pick it from a list easily and know
at first glance that you have the right coordinate system, and Figure 3 shows this for our sample model.

Next, we need to turn on symmetry.  You do this by clicking on the Model (top of the tree) and inserting a Symmetry branch in the tree.
Click on the branch and look at the Details and you will see a bunch of beta options Called Graphical Expansion 1, 2 and 3.  We will
just use the first one.  Enter in the number of times your model repeats, set the type to Polar and put in the angle of your periodic section

Modeling Cyclic
Symmetry in ANSYS

Mechanical R12.1

Figure 3: Define Cylindrical Coordinate
System

Figure 1: Turn on Beta Features Figure 2: Set System Variables Up

(Cont. on pg. 7)
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(this should be (Num Repeat)/360.  Lastly, specify the axis coordinate system you just set up. Figure 4 shows the
details view for the test model used for this article.

After you have supplied the key geometry values, you have to define your periodic boundaries.  Do this by
right-clicking on the Symmetry folder and inserting a Periodic Region object.  Now define your Low and High
periodic boundaries in the detail view by clicking on the surfaces.  If you boundary has more than one surface on
it, make sure you pick all the surfaces.  ANSYS Mechanical APDL will apply the constraint equations for cyclic
symmetry between the two groups of surfaces you define here.  Next, define the Coordinate System as your axis
coordinate system, as shown in Figure 5.

Step 3: Set up match meshes on Periodic Boundaries
ANSYS has a very nice feature for cyclic symmetry where the nodes on your periodic boundaries don’t have to
line up.  But this introduces some inaccuracy and slows down the solve a bit.  So we recommend that you tell the
mesher to line up the nodes on the boundary. Do this by inserting a Match Control under the Mesh branch of the
tree.  You will need a Match Control for every pair of faces on your boundaries.  Once you have selected the
faces, you need to set Transformation=Cyclic and once again specify your axis coordinate system as the Axis of
Rotation.  Figure 6 shows this for the example model.

Step 4: View the expanded mesh
At this point, you can specify your normal mesh controls, mesh the geometry and view
the results.  If you want to see a 360° version of the mesh, go up to the View menu and
choose Visual Expand (beta), as shown in Figure 7.  This can make some nice plots and
is a good way for you to check and make sure you set up the periodic symmetry
definition correctly.

Step 5: Setup solve
From here on out you should do everything pretty much like you always do.  Define
your boundary conditions, material properties, solve options, etc…  But before you
click on the lightning bolt to solve, you need to tell ANSYS what harmonic indices you
want to run.  By default ANSYS solves only the 0th harmonic index.  So if you want
more, you need to add a command object with a cycopt command in it.  For the test
model, we used cycopt,hindex,0,5 to give harmonic indices 0 through 5. Now don’t get
all huffy about a command object, remember this is beta and it is just one line.

Now you are ready to solve.

Step 6: Post process the expanded re-
sults
After the solve do your normal post
processing steps for a modal analysis:
insert a displacement object for the first
mode and calculate the results.  This will
bring up your mode list. Select the list,
right-click and choose “Create Mode
Shape Results.”  Calculate those results
and click on one.  You should see a 360° plot showing your complex mode shape.  Pick
some values from a higher harmonic index and you should see the nodal diameters.  If
you set cycWave to 1, when you animate you should see the traveling wave. Figure 8
shows some plots from the sample model.

You can download the sample workbench project at:
ftp.padtinc.com/public/thefocus/R121cyclo.zip.  The results have been removed to

reduce the file size, so you will need to rerun it.

Figure 4: Specify
Symmetry Values

Figure 5: Define Periodic Boundaries

Figure 6: Define Mesh Match Surfaces

Figure 7: Expanded Mesh

Figure 8: Typical Results for Different Harmonic Indices

(Cyclo, Cont...)

ftp://ftp.padtinc.com/public/thefocus/R121cyclo.zip
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By: Jeff Strain
As ANSYS migrates the Workbench interface from 1.0 to
2.0 format, one of the "themes" being integrated into the
interface is the global, rather than module-specific, man-
agement of data.  The idea is to define data items in a single location
which is referenced by all modules associated with a given project.

In this issue of the Focus, I'll describe how the Parameter Manager has
been migrated from a local Workbench 1.0 tool to a global Workbench
2.0 format and define how to use it to perform "what-if" studies and
examine trends.

The Parameter Manager is going to consist of inputs and outputs.  Inputs
are items such as geometric dimensions, numbers of holes or ribs,
material property values, and load quantities. Outputs would consist of
calculated items such as stresses, temperatures, displacements, and
masses.

To access the Parameter Manager, at least one quantity must be flagged
as a parameter.  Do this by clicking the box next to the quantity of
interest. This will place a D (in DesignModeler) or P (in Mechanical née
Simulation) in the box (Figure 1).

Once a parameter has been assigned, the Parameter Manager cells will
appear on the Project Page.  The arrow on the left side of the cell
indicates that at least one input parameter has been
defined. Once an output parameter is defined, an arrow
appears on the right side (Figure 2)

To access the Parameter Manager, simply double-click
(or right-click > Open) the Parameter cell.  It doesn't
matter which one; they both work.

Once you open the Parameter Manager, you'll see a
single layer of windows.  Although the Parameter Man-
ager appears somewhat cluttered, everything is accessi-
ble without having to open a new window (Figure 3).

The first thing you'll want to do is fill in the input
parameters. Simply click in a blank cell in the Table of Design Points (upper right) and start typing. Once you hit Enter, a new row will be
added.  If you leave a cell blank, it will default to the "Current" value (Figure 4)

Once you've entered the input parameters into the Design Points table, solve for the outputs by clicking the Update All Design Points (double
lightning bolt) button.  Be sure to also click the OK button in the window that pops up.  It's not entirely obvious, but the solution won't start
until you click OK.

(Cont. on pg. 9)

Figure 1:  Parameter Specification

Figure 2: Parameter Manager Cells

Figure 3: Parameter Manager

Figure 4: Define Periodic Boundaries



February 4, 2010 The Focus  Issue 72

www.padtinc.com  9 1-800-293-PADT

Once the runs have completed and assuming no errors
have been encountered (you didn't make the hole big-
ger than the part, did you?), the output parameter
values  in the Table of Design Points will be filled in
(Figure 5).

At this point, consider what values you wish to plot on
the trend chart.  Once you've decided that, highlight an
appropriate parameter in the Outline of All Parameters.
Once you do this, various chart options appear on the
left (Figure 6).

Double-click the appropriate op-
tion.  A chart object will be ap-
pended to the Outline of All
Parameters.  Define additional
data to be plotted in the Proper-
ties of Outline window (Figure
7).

Once you've defined the chart
data, voila, you have a chart
(Figure 8).

To delete a chart object or design
point, simply right-click the row
to be removed and select the delete option (Figure 9).

To set the current analysis to reflect a given design point, right click
the design point and select Copy inputs to Current.  Then right-click
the Current Design Point and select Update Selected Design
Points (Figure 10). To return to the Project Schematic, sim-
ply click the “Return to Project” button in the top toolbar.

While the Parameter Manager is good for what-if studies and
basic trends, consider using DesignXplorer for more ad-
vanced capabilities such as 3D response surfaces, design
optimization, design for six sigma, and correlation studies.
Many of you have a license for DesignXplorer and don't even realize it.

(Parameters Cont...)

Figure 5: Completed Design Point Table

Figure 6: Inserting a Chart

Figure 7: Define a Chart

Figure 8: Voila! A Chart

Figure 9: Deleting Charts and Design Points

Figure 10: Updating a Model to a Design Point
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By :Carlos Shultz
ANSYS is ideally capable of analyzing the sport of baseball.  So you may be thinking...  ball...bat...hmmmm?  Could he have used
DYNA to tune a composite bat to its ideal thickness and shape to blast fastballs over the fence?  How about a CFX analysis showing the
kind of action you can get from a spit ball.  Maybe something practical like an EMAG solenoid optimization analysis to reduce electricity
usage in the many sprinklers required for field maintenance.  Nothing so obvious was done.

Last spring my daughter played on a local little league team which led me to think about how to determine the optimal batting order?
ANSYS has the APDL available to do Monte Carlo simulations which are simulations often used when deterministic solutions are not
obvious.  There are 2 aspects of the game which make solutions to this problem difficult to determine without a Monte Carlo simulation.
The results of any game are significantly affected by the order of batters and the results of each at bat.  Compounding this are the league
rules that limits each inning to 5 runs (innings end when the 5th run of an inning is scored) and allow stealing (except home) which
means that players on base will automatically advance to the last open base (because there are lots of passed balls).

The code consists of 2 macros.  The first macro controls the solution algorithm and repeatedly calls the second macro which runs a
simulated game.  The user can specify a fixed lineup or allow ANSYS to randomly order the batters.   The results of each at bat are
determined using random probability along with each batters walk, hit, and extra base hit statistics (see the example of batters data usage
below).  Generally the best batters go first and the worst batters go last; however, it was found that when there is a 5 run rule, it is
advantageous to move some of the weaker batters up in the order rather than clustering them at the end.

Example of Batters Data Usage:
a=rand(0,1)  assign a random number

Compare the random number to the batters statistics.

data1(1,1)=0.30 a <= 0.30   process a walk
data1(1,2)=0.75 0.30 < a <= 0.75 process a hit
data1(1,3)=0.80 0.75 < a <= 0.80 process a double
   0.80 < a  process an out

The first task was to find convergence and to insure that the sample sizes used had acceptable variance.  Case 1, which is a traditional
lineup with the best batters first and the worst batters last, was run 3 times with the number of iterations shown below.  The best results
(highest total runs average) were collected and are shown in Table 1.   The results show that 5,000 iterations has converged to an
acceptable amount.

Case 1 was then run 3 more times with 5000 iterations to verify that the variability was small.  The variability of total runs, shown in
Table 2, was considered an acceptable amount.

Batter Up:  APDL Takes a Swing at Sports

Runs
Case Iters Inn1 Inn2 Inn3 Inn4 Inn5 Total

1a 10 4.7 1.6 4.2 3.9 3.7 16.5
1b 100 4.3 1.8 3.6 2.6 2.9 15.1
1c 1000 4.3 1.7 3.3 2.7 2.7 14.6
1d 5000 4.3 1.7 3.2 2.6 2.8 14.7
1e 10000 4.3 1.7 3.3 2.6 2.8 14.7

Table 1: Case 1 run with increasing iterations (3 simulations per case,
best result shown)

Runs
Case Iters Inn1 Inn2 Inn3 Inn4 Inn5 Total

1f 5000 4.3 1.7 3.3 2.6 2.8 14.7
1g 5000 4.3 1.7 3.3 2.6 2.8 14.6
1h 5000 4.2 1.8 3.2 2.6 2.7 14.5

Table 2: Case 1 run 3 times with 5000 samples

2010 PADT Webinars
This year PADT is making a full switch to web based semi-
nars away from the lunch-centered events of the past.
Weight gain amongst speakers and frequent visitors did
play a role.  We decided to offer to series:  a Technical one
and a Product focused one.  Anyone can attend and we
hope to see more Focus readers swelling our numbers.

Technical Series Product Series

2/25/10 Meshing Update 3/9/10
Detailed Fatigue
Calculations with nCode
and ANSYS

3/25/10 Modeling Composites with
ANSYS 4/6/10 Maximizing the ROI of

your CAE Investment

4/22/10
New, Interesting and
Underused Elements in
ANSYS Mechanical APDL

5/4/10 Optimization with ANSYS
Design Xplorer

(Cont. on pg. 11)

http://en.wikipedia.org/wiki/Monte_Carlo_method
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Next, a variety of cases was run including a baseline, some intuitive models, and then a batch of 200 random models (the best 5 random
results are included in Table 3).  The results show a wide spread between the best and worst possible lineups (from 12.8 to 15.3 total
runs per game).  The best lineups showed that distributing the weaker hitters throughout the lineup instead of clustering them produced
better results.

To determine the significance of the 5 run rule...the restriction was lifted.  The results in Table 4 show that the Baseline case which is
based upon conventional baseball wisdom is quite correct; hitters should be ordered from best to worst.

Code Highlights
The compact bit of code below takes an array b(12) which is populated with random numbers between 0 and 0.1 and replaces them with
the batter numbers from order(12).  Because the batter numbers are 1 or greater...the new values of b insure that each row is picked only
once.

*do,i,1,12
 *VSCFUN,lmin_,LMIN,b
 b(lmin_)=order(i)
*enddo

Whenever you use random number generation in ANSYS, make sure you initialize it since it is a psuedo random number generator.
Here is an example of using the wall time to move to a random starting point in the random sequence:

*GET,DIM,ACTIVE,0,TIME,WALL
DIM=DIM*3600
*del,dummy,,nopr
*DIM,DUMMY,ARRAY,DIM
*VFILL,DUMMY(1),RAND
*DEL,DIM,,nopr
*DEL,DUMMY,,nopr

The entire code, which is about 250 lines, is available with examples at ftp.padtinc.com/public/thefocus/Batter_APDL.zip.

Batting Order Runs
Case Description Type of Batter: 1=average 2=strong 3=weak Inn1 Inn2 Inn3 Inn4 Inn5 Total

1 Baseline 2 1 1 1 1 1 1 1 1 3 3 3 4.3 1.7 3.2 2.6 2.8 14.7
2 Reverse 3 3 3 1 1 1 1 1 1 1 1 2 1.2 3.5 2.5 2.9 2.8 12.8
3 Spread 1 1 1 1 1 1 1 2 3 1 3 1 3 3.9 2.5 2.8 3 2.8 15
4 Spread 2 1 1 1 1 1 3 2 1 3 1 1 3 3.5 2.9 2.8 3 2.9 15.1
5 Spread 3 1 1 1 3 1 1 2 3 1 1 1 3 3.3 2.9 3 2.9 2.9 15
6 Random 1 2 1 1 1 1 3 1 1 1 3 3 1 3.7 2.8 2.7 3.1 2.8 15.1
7 Random 2 2 1 1 1 1 1 1 3 1 3 1 3 3.9 2.7 2.6 3.1 2.7 15.1
8 Random 3 1 1 1 1 3 1 2 1 3 1 3 1 3.5 2.8 2.8 3 2.9 15
9 Random 4 1 1 1 1 2 3 1 1 3 1 1 3 3.6 2.9 2.8 3.1 2.9 15.3

10 Random 5 2 1 1 1 1 3 1 1 3 1 1 3 3.5 3.1 2.7 3 3 15.3
Table 3: A Variety of Cases run 3 times with 5000 samples

Batting Order Runs
Case Description Type of Batter: 1=average 2=strong 3=weak Inn1 Inn2 Inn3 Inn4 Inn5 Total

1 Baseline 2 1 1 1 1 1 1 1 1 3 3 3 5.4 3.8 3.7 3.8 3.8 20.5
2 Reverse 3 3 3 1 1 1 1 1 1 1 1 2 1.6 4.4 3.9 3.8 3.9 17.5
3 Spread 1 1 1 1 1 1 1 2 3 1 3 1 3 4.8 3.8 3.8 3.8 3.8 20.1
4 Spread 2 1 1 1 1 1 3 2 1 3 1 1 3 4.5 3.8 3.7 3.7 3.8 19.5
5 Spread 3 1 1 1 3 1 1 2 3 1 1 1 3 4 3.7 3.8 3.8 3.8 19.1
6 Random 1 2 1 1 1 1 3 1 1 1 3 3 1 4.6 3.8 3.7 3.9 3.7 19.8
7 Random 2 2 1 1 1 1 1 1 3 1 3 1 3 4. 9 3.8 3.6 3.8 3.8 20
8 Random 3 1 1 1 1 3 1 2 1 3 1 3 1 4.2 3.8 3.7 3.8 3.7 19.2
9 Random 4 1 1 1 1 2 3 1 1 3 1 1 3 4.5 3.8 3.7 3.8 3.7 19.6

10 Random 5 2 1 1 1 1 3 1 1 3 1 1 3 4.5 3.9 3.7 3.8 3.8 19.6
Table 4: A Variety of Cases, without the 5 run rule, run 3 times with 5000 samples

APDL, Cont...)

http://en.wikipedia.org/wiki/Pseudorandom_number_generator
ftp://ftp.padtinc.com/public/thefocus/Batter_APDL.zip


February 4, 2010 The Focus  Issue 72

www.padtinc.com  12 1-800-293-PADT

In the past we have finished up The Focus with a page we called “Shameless Advertising...”
The truth was that the page was really only advertising PADT, and PADT related things.  So,
instead of doing advertising we thought we would just dedicate the final page to explaining
who PADT is, what we do and how we can hopefully help you.  And, to make sure you read
it, we will try and stick something funny in.  Want to know more?  Call Stephen Hendry at
207-333-8780 or e-mail steve.hendry@padtinc.com.

Humor:
Here are some funny, and some groan worthy, computer, programming, and math related one-liners:

� 2 + 2 = 5 for extremely large values of 2.
� Computers make very fast, very accurate mistakes.
� BREAKFAST.COM Halted...Cereal Port Not Responding
� Ethernet (n): something used to catch the etherbunny.
� Does fuzzy logic tickle?
� A computer's attention span is as long as it's power cord.
� If debugging is the process of removing bugs, then programming must be the process of putting them in.
� Relax, its only ONES and ZEROS!

CFD Services
When most people think about PADT’s simulation services they think of mechanical and thermal
simulation.  That is the bread and butter that this part of the company’s business was built on, and is
certainly an area of expertise.  The problem is that PADT is so well known in this area that many people
do not think of us when it comes to simulating fluid behavior, what we like to call CFD.

The truth is that PADT has three full time engineers who specialize in just that type of simulation.  As you would expect, their tool
expertise focuses on ANSYS CFX and ANSYS FLUENT and is applied to not only doing simulation runs for others.  They also
provide the type of engineer-to-engineer technical support to our CFX and FLUENT users that PADT is famous for.  The same skills
are applied to training and mentoring to customers around the world.
The area of customization, a well known strength of PADT for ANSYS Mechanical APDL, also exists for users of ANSYS, Inc’s
CFD tools.  Not only can our engineers customize your meshing, setup, solving or post processing process,
but they are also certified to create User Defined Functions (UDF’s) for ANSYS FLUENT users.
All of this experience and knowledge is backed up with our computer cluster, which has over 100 nodes
and is growing.  To learn more, contact Stephen Hendry at 207-333-8780 or e-mail
steve.hendry@padtinc.com.

PADT on the Web
www.PADTINC.com  PADT’s main website

www.PADTMedical.com Medical device development
www.DimensionSCA.com A machine that PADT makes

www.PADTMarket.com A place to buy 3D Printers & Supplies
www.XANSYS.org ANSYS User forum

Need ANSYS Help?
PADT can help in many different ways, here are a few:

� We hold training here or at your facility <link>

� Leverage our APDL knowledge with the APDL Guide <link>

� Consider one-on-one support through mentoring, a great
way to get a quick start on something new <link>

� Attend a PADT Webinar <link>
Join us on Facebook!

Search for  PADT, Inc. and become a fan!

mailto:steve.hendry@padtinc.com
mailto:steve.hendry@padtinc.com
http://www.padtinc.com
http://www.padtmedical.com
http://www.dimensionsca.com
http://www.padtmarket.com
http://www.xansys.org
http://www.padtinc.com/support/training/
http://www.padtinc.com/support/techguides/
http://www.padtinc.com/support/mentor/
http://www.padtinc.com/epubs/seminars/default.asp
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